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● Safety precautions 
 Before you use the printer, carefully read the User’s manual to ensure that you use the printer 

correctly. Be aware that the content complies with the standards at the time the User’s manual section 
related to safety, including usage and safety precautions, was created. 

 
● Modifications 
  For product safety, it is prohibited to modify the CX-02W/CX-02W (A) printer, CX-02W/CX-02W (A) 

printer driver, and CD contents. 
 
● Copyright 
 The copyrights, trademark rights, and other intellectual property rights related to documents and 

programs included with this product are the property of CITIZEN SYSTEMS JAPAN and other rights 
holders. You cannot copy and use these items without the permission of CITIZEN SYSTEMS JAPAN 
except where permitted by applicable laws. 

 
 Microsoft and Windows are trademarks or registered trademarks of Microsoft Corporation in the United 

States and in other countries. 
 LEADTOOLS Copyright (C) 2008 LEAD Technologies, Inc. 
 
● About the product destination 

You cannot resale/use the CX-02W without destination number (A) in the U.S. 
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Chapter 1 Installation 
 
Installation procedure 

The installation procedure is made up of three steps. 
The details of each step are explained below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Step 2  Install the driver package → “1.2 Install the driver package” 

Step 1  Prepare the printer and computer → “1.1 Prepare the printer and computer” 

On 

USB cable 

Insert the included CD into the disk drive, and then 
install the driver package. 

Step 3  Install the printer driver → “1.3 Install the printer driver” 

Connect the USB cable, switch on the printer, and then 
install the printer driver. 
After installation is complete, restart the computer. 

At this point, the USB cable is not yet 
connected. 
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1.1 Prepare the printer and computer         
Make sure that the printer power is off. 
Prepare a USB cable. However, do not use the USB cable to connect the printer and computer at this time. 
 
Log in to Windows as an administrator. The following explanation presumes that the operations are carried 
out with administrator privileges. 
 
 
 
 
 
 
 
 
 
 
 

1.2 Install the driver package                  
Insert the included CD into the disc drive. 
Open Windows Explorer, and then click the corresponding drive. 
If AutoPlay is enabled, a message appears stating “Tap to choose what happens with this disk”.  Click the 
message and select “Open folder to view files Windows Explorer”. 
If AutoPlay is enabled in Windows 7, select “Open folder to view files using Windows Explorer”. 
If AutoPlay is enabled in Windows 8, a message appears stating “Tap to choose what happens with this disk”. 
Click the message and select “Open folder to view files Windows Explorer” 
 
Select one of the following folders on the included CD. 
 
 CD drive:\\CX-02W_Driver 
 

 
Figure 1.2.1 Driver Package folder 

 
  

CAUTION: 
The display settings of the computer must be set as follows.  If the settings differ from the following, 
the printing preferences screen and other items may not fit in the display area. 
 
· Resolution: At least 1280x800 
· Size of text and other items (DPI): 100% 
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In the selected folder, double click the following file: DriverInstall.CMD. (Depending on your usage 
environment, the .CMD extension may not be displayed.) 
The driver package installer appropriate for your operating system (32-bit or 64-bit) is selected automatically. 
 

 
Figure 1.2.2 Installation file 

 
 
When you start the installer, a window appears for selecting the language that will be used during the 
installation. 
After you select the language to use, click “OK”. 
 

 
Figure 1.2.3 Language selection screen 

 
 
Click “Next >” when the Installation Wizard screen appears. 
 

 
Figure 1.2.4 Installation Wizard start screen 
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Click “Install” when the installation is ready. 
 

 
Figure 1.2.5 Installation start confirmation screen 

 
 
When the installation starts, a screen appears that shows the installation status.  
 

 
Figure 1.2.6 Installation status screen 
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When a User Account Control dialog box appears, click “Yes”. 
 

 
Figure 1.2.7 User Account Control 

 
 
Click “Install” when the Windows Security confirmation display appears. 
 

 
Figure 1.2.8 Windows Security confirmation 

 
 
Installation of the driver package starts. Wait until installation finishes. 
Click “Finish” when the Installation Wizard completion screen appears. 
 

 
Figure 1.2.9 Finish of Installation Wizard 
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1.3 Install the printer driver  
 
Use the USB cable to connect the printer and computer, and then switch on the power of the printer. 
After the printer is recognized, installation of the driver starts. 
*For the connection, see the User’s manual of the printer. 
 
In Windows 7, if driver installation starts, the following message appears in the taskbar: “Installing device 
driver software”. 
In Windows 8 and 10, this message does not appear.  Proceed to page 8. 
 

 
Figure 1.3.1 Driver installation message 

 
 
If you click on this message, the Driver Software Installation screen appears and displays the installation 
status of the driver. If “Close” is clicked, this screen closes. 
 

 
Figure 1.3.2 Installing the driver software 

 
 
*About the “Skip obtaining driver software from Windows Update” option 
If your operating system is configured to obtain driver software from Windows Update, it may take time for 
installation to complete because the process searches for drivers from Windows Update first. You can reduce 
the time until the completion of installation by choosing to skip obtaining driver software from Windows 
Update. (Depending on your operating system, it may take some time until installation is complete.) 
From the Driver Software Installation dialog box, click “Skip obtaining driver software from Windows Update”. 
 

 
Figure 1.3.3 Option to skip obtaining driver software from Windows Update 
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A confirmation dialog box appears. Click “Yes”. 
 

 
Figure 1.3.4 Confirmation to skip getting driver software from Windows Update 

 
 
Soon after installation starts, a message appears in the taskbar stating “Your device is ready to use”, and then 
printer driver installation finishes. 

 
Figure 1.3.5 Installation complete message 

 
 
If you click on the message, the Driver Software Installation dialog appears, and the “Your device is ready to 
use” message appears. Click “Close”. 
(If the Driver Software Installation screen is open when installation starts, the abovementioned taskbar 
message is not displayed.) 
 

 
Figure 1.3.6 Completion of driver software installation 
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Click “Start”, and then click “Windows System” -> “Control Panel” to open the Control Panel. 
In Windows 7, click “Start”, and then click “Control Panel” to open the Control Panel. 
In Windows 8, right click the “Start” screen.  In the bottom right area, select “All Apps”, and then select 
“Control Panel”. 
In Control Panel, click “View devices and printers”. 
 

 
Figure 1.3.7 Control Panel 

 
 
In Devices and Printers, make sure that “CITIZEN CX-02W” is present. 
Note: In Windows 8 and 10, when the printer is offline (the printer is not on and connected), the “CITIZEN 

CX-02W” icon is not displayed. 
This completes installation of the printer driver. 
 

 
Figure 1.3.8 Devices and Printers screen 

 
After the installation of the printer driver is complete, always restart the computer.  
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In Windows 7, when it was not possible to install the printer driver correctly, the following message appears in 
the taskbar: “Device driver software was not successfully installed”. 

 
Figure 1.3.9 Message indicating that the driver was not installed 

 
 
If you click on this message, the Install driver software screen appears and displays the message “Device 
driver software was not successfully installed”. Click “Close”. 
(If the Driver Software Installation screen is open when installation starts, the abovementioned taskbar 
message is not displayed.) 
 
When the driver could not be installed correctly, see the next section, “1.4 Install drivers for unspecified 
devices”, and then install the printer driver. 
 

 
Figure 1.3.10 When the driver was not installed correctly 
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1.4 Install drivers for unspecified devices  
 
If you connect a printer that is on to the computer before installing the driver package, a device is created 
under “Unspecified” in Devices and Printers.  
 

 
Figure 1.4.1 Photo Printer under Unspecified 

 
In such a case, use the following method to install the printer driver. 
Furthermore, use the following method to install the printer driver if you use the standard installation 
procedure (install the driver package, connect the printer, and then install the printer driver), but the driver is 
not installed correctly, and a device is created under “Unspecified”. 
 
 
1. Install the driver package 
  When the driver package has not yet been installed, install it by following the procedure in “1.2 Install the 
  driver package”. 
  If you install the driver package, installation of the printer driver for the unspecified device completes it 
  automatically. 
 
 
2. Installing a driver for an unspecified device 

After installing the driver package, the driver installation procedure for an “Unspecified” device is different 
for Windows 7 and Windows 8,10. 
For Windows 8,10, refer to page 11. 
For Windows 7, refer to page 12. 
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In Windows 8,10: 

1. Right-click “Photo Printer” of the “Unspecified” device in “Devices and Printers”, and click “Remove 
device” from the pull-down menu. 
 

 
Figure 1.4.2 Delete “Photo Printer” 

 
2. Disconnect the USB cable connected to the printer. 
3. Restart your computer. 
4. After starting up the computer, connect the USB cable again and turn on the printer. 

 
In Devices and Printers, make sure that “CITIZEN CX-02W” is present. 
Note: When the printer is offline (the printer is not on and connected), the “CITIZEN CX-02W” icon is not 

displayed. 
This completes installation of the printer driver. 
 

 
Figure 1.4.3 Devices and Printers screen 

 
After the installation of the printer driver is complete, always restart the computer. 
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In Windows 7: 
  In “Devices and Printers”, under “Unspecified”, right click on “Photo Printer”. From the menu, click 
  “Troubleshoot”. 
 

 
Figure 1.4.4 Photo Printer under Unspecified 

 
The Install a driver for this device screen appears. Click “Apply this fix”. 
The computer searches for a driver automatically, and then installs it. 
 

 
Figure 1.4.5 Applying a fix 
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If the driver is installed, the message “Troubleshooting has completed” appears. Click “Close the 
troubleshooter” to close the troubleshooting window. 
 

 
Figure 1.4.6 Completing troubleshooting 

 
In Devices and Printers, make sure that “CITIZEN CX-02W” is present. 
This completes installation of the printer driver. 
 

 
Figure 1.4.7 Devices and Printers screen 

 
 
After the installation of the printer driver is complete, always restart the computer. 
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Chapter 2 Properties 
 
You can configure various printer settings from the Properties of the driver. Make sure you understand the 
contents well before changing settings. To use the properties, log in as an administrator. Depending on the 
application you are using, you must perform this operation from the print settings of the application. 

2.1 Open the printer properties  
 
 
 
 
 
 
 
 

   
 
 
 
 
 

   
 
  

2. From the Control Panel, click “View devices and printers” to open the Devices and Printers screen. 
 

1. Click the “Start”, click “Windows System”, and then click “Control Panel” to open the Control Panel. 
In Windows 7, Click “Start”, and then click “Control Panel” to open the Control Panel. 
In Windows 8, right click the “Start” screen, click “All Apps”, and then click “Control Panel” to open 
the “Control Panel”. 
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4. The “CITIZEN CX-02W” Properties screen appears. 

3. Right click “CITIZEN CX-02W” icon. From the menu, click “Printer Properties” to open the Properties 
  dialog box.  

Note: In Windows 8 and 10, when the printer is offline (the printer is not on and connected), 
“CITIZEN CX-02W” icon is not displayed. 
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2.2 Print settings functions  
If you select the basic settings from the Properties screen, you can change various print settings. 
 
2.2.1 Layout 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Orientation 

  Set the print orientation to “Portrait” or “Landscape”. 
  For details, refer to “2.6 Orientation”. 
 
Page Order 

  In the application, specify the order when multiple copies of an image are printed. 
 
  Example) Print order 
 
 
 
 
 
 
 
 
 
 
Page Format 

  Pages per Sheet 
    Set printing of the specified division size. In most situations, set “1”. 
 
    Example) Division size 
 
 
 
  

Back to Front  

Front to Back 

No.1 No.2 No.3 

Figure 2.2.1 Layout tab 

1 division 
 

4 divisions 9 division 
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2.2.2 Advanced options 

If you select “Advanced...” on the Layout tab, you can configure various advanced options. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Paper/Output 

  Paper Size 
    Specify the paper size. The paper size that can be specified depends on the media size that is loaded 
    in the printer. If the printer is offline, the loaded media size is assumed to be A4. Multiple layout will be 
    automatically used depending on the specified paper size. 

For details, see <Multiple layout> described later. 
Loaded media size Specifiable paper size Multiple layout 

8x10(*1) 8x4, 8x5 Enable 
8x6, 8x8, [8x10] Disable 

8x12(*1) 8x4, 8x5, 8x6 Enable 
8x8, 8x10, [8x12] Disable 

A4(*2) A5 Format, 8x4, 8x5 Enable 
[A4 Format], 8x6, 8x8, 8x10 Disable 

    The paper size in square brackets [ ] is the default paper size for the loaded media. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Figure 2.2.2.2 Advanced options tab Figure 2.2.2.1 Advanced settings 

Figure 2.2.2.3 Incompatibility media size  
(Gray out indication) 

Figure 2.2.2.4 Incompatibility media size  
(Warning indication) 

 

*1: Paper sizes that cannot be used for printing 
are grayed out. 

*2: For paper sizes that can create margins on the 
sides of the output results, a warning appears. 



 

18 
CITIZEN SYSTEMS JAPAN CO., LTD. 

 

[CX-02W/CX-02W (A) Printer Driver] User’s Manual (For Windows 7, 8 and 10) 
 

 
  Copy Count 
    You can specify the number of copies to be published for images. 
 
 
Graphic 

  Print Quality 
   Specify the resolution. 

Print quality Function 
High-speed Print using high speed mode 
High-quality Print using high quality mode 

 
  ICM Method 

ICM Method Function 
ICM Disabled Synchronized with “Color Adjustment Disabled” in the 2.2.4 

Option. 
ICM Handled by Host System Synchronized with “Color Adjustment ICM” in the 2.2.4 Option. 

Manage colors using the driver. 
ICM Handled by Printer When this item has been selected, operation is the same as “ICM 

Handled by Host System”. 
 
  ICM Intent 
    Set the rendering method when using ICM. For the ICC profile, always set to “Pictures”. 
    Do not use other settings. 
 
 
Document Options 

  Advanced Printing Features 
    Always set “Enabled”. Do not use other settings. 
 
  Pages per Sheet Layout 
    Set the layout direction of an image when the Pages per Sheet setting is set for multiple divisions. 
 
 
Printer Features 

  Border 
    Synchronized with Border in the Option. 
 
  Overcoat Finish 
    Set the overcoat finish method for the surface of printed items from the following three types. 

Overcoat Finish Function 

Glossy Create an item with a glossy finish. 
Luster Create printouts with rough surface and semi-gloss finish that has less 

glare.  
Matte Create an item with a matte finish. 
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  Print Re-try 

Specify whether to print data in the printer buffer after a printer error has been cleared. 
Print Re-try Function 

Disable Clear the print data in the printer buffer when a printer error occurs. 
You must send the cleared print data again after the error is cleared. 
When you use an application with an error recovery function, select this 
option. 

Enable Save print data in the printer buffer when an error occurs. 
The printing process is restarted from the saved data after the error is 
cleared. 
Note that if the power is switched off, the data is not saved. 

 
Depending on the printer error, print data in the print buffer will be cleared, regardless of the Print Re-try 
setting. 
 
The following section shows the operation for each Print Re-try setting by error. 

Error content When Print Re-try is disabled When Print Re-try is enabled 
Paper end You must send the unprinted image 

data again after the error is cleared. 
The printing process is restarted 
from the data saved in the printer 
buffer after the error is cleared. 
When the paper initialization 
operation is to be carried out, 
printing occurs afterwards. 

Ribbon end 

Door open 

No scrap box 

Paper jam To prevent the occurrence of an error, printing will not be restarted, 
regardless of the Print Re-try function setting. 
After the printer stops due to an error, follow the user's manual of the 
printer to eliminate the cause of the paper or ribbon error. 
You must send the unprinted image data again after the error is cleared. 

Ribbon error 

Paper size setting error 

System error Because the printer must be switched on and off to clear the error, the 
print data in the printer buffer is cleared regardless of the Print Re-try 
setting. 
 
After the printer has restarted, you must send the unprinted image data 
again. 
 

･Data error 

･Head voltage error 

･Head position error 

･Power supply fan stopped 

･Cutter error 

･Head temperature error 

･Media temperature error 

･RFID module error 
 

 
 High density mode 
   Enables or disables high density mode. 
    This function is valid only when Print Quality is “High-quality”. 

High density mode Function 

Disable Prints with normal density. 
Enable Prints with an optical density higher than the maximum density. (*1) 

  *1: Printing time increases over printing with normal density, and the Rewind Print function is also 
       disabled. 
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＜Multiple layout＞ 

Multiple layout can be specified in the paper size settings of the printer driver. When multiple images are 
sent from the application, multiple layout is automatically used by the printer driver. 

 

Loaded media Paper size setting Paper size 
width x height (mm) 

Maximum allocation 
counts 

8x10 (8x4) 207.3x104.6 2 
(8x5) 207.3x130.0 2 

8x12 (8x4) 207.3x104.6 3 
(8x5) 207.3x130.0 2 
(8x6) 207.3x155.4 2 

A4 A5 Format 214.0x151.5 2 
(8x4) (*1) 207.3x104.6 2 
(8x5) (*1) 207.3x130.0 2 

  
  Multiple layout is carried out under the following conditions. 

 1. Set the paper size of the printer driver to one of the abovementioned paper sizes.  
 2. Send multiple images from the application. (*2) 

 
 Note) 
    *1 :  Margins can be created on the sides of the output results. 
    *2 :  Depending on usage, rewind printing may be used instead of multiple layout printing. 
 Because they are carried out by the print job, multiple layout are carried out when there are 
 multiple images in a single job.  
 If you want to layout the same image, send the same number of images as the number-of-sheets 
 setting. 
 The printer prints two or three screens worth of images at one time and cuts the paper to the set size 

when the paper is ejected. 
 
＜Multiple layout patterns＞ 

The following combinations are possible for the multiple layout patterns. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Same-size images on one sheet 
Layout of 2 pictures Cut when paper is ejected 

Cut when paper is ejected 
Same-size images on one sheet 
Layout of 3 pictures 
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< The rewinding print function > 

This function performs optimal printing that controls ribbon consumption when printing 8x4 and 8x5 size 
prints on 8x10 size media. 

 
In the same manner, it also performs optimal printing that controls ribbon consumption when printing 8x4, 
8x5, and 8x6 size prints using 8x12 size media, and A5 Format, 8x4, and 8x5 size prints using A4 size 
media. 

 
The above operation applies only to the CX-02W. The CX-02W (A) performs printing without rewinding the 
ribbon. 

 
The following shows the difference in ribbon consumption when (8x4) is specified for the paper size setting 
for 8x10 size media. 

 CX-02W CX-02W (A) 

When printing one sheet at 
8 x 4 size once 

 
 
 
 
 
 
*After printing, the ribbon is rewound and 
adjusted to the next print position. 

 

When printing one sheet at 
8 x 4 size twice 

 
 
 
 
 
 
*After the first sheet is printed, the ribbon is 
rewound, and the second sheet is printed. 
 

 

When printing two sheets at 
8 x 4 size once 

 
 
 
 
 
 
*Two sheets are printed at the same time in a 
multiple layout. 
 

 
 
 
 
 
 
*Two sheets are printed at the same time in a 
multiple layout. 
 

When printing one 8 x 4 size 
sheet once, and then 
printing two 8 x 4 size 
sheets once 

 
 
 
 
 
 
 
 
 
 
 
*After the first sheet is printed, the ribbon is 
rewound, and the second and following sheets 
are printed. Furthermore, after the third sheet 
is printed, the ribbon is rewound and adjusted 
to the next print position. 

 
 
 
 
 
 
 
 
 
 
 
*For the second and third sheets, two sheets 
are printed at the same time in a multiple 
layout. 

  

 

 

Not 
used 

 

Used for the 
next printing 

 

Used for the 
next printing 
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< Application usage example > 

 This usage example uses Windows Explorer. 
  

Step 4. Set the Orientation to “Portrait”, 
       and click “Advanced...”. 
 

Step 1. In Windows Explorer, select two or more pictures. 
Next, click “Print”. 

Step 2. Select “Fit picture to frame” check box, and 
then click “Options...”. 

 

Select 2 or more images 

Step 3. Click “Printer Properties...”. 

Step 6. Click the “Print” button. 

Step 5. Set the paper size to the setting of the 
multiple layout. 
Click “OK” twice to close the dialog boxes in 
Step 5 and 4. 
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2.2.3 Paper/Quality 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Color  Set Color. Do not use black and white. 
 
 
2.2.4 Option 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Border 
    Specify a border for printing. (Select the check box for a border.) Synchronized with Border 
    Enable/Disable in the Advanced settings. 
 
 
  

Figure 2.2.3 Paper/Quality tab 

Fig 2.2.4.1  Option tab Fig 2.2.4.2  Sharpness setting 
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Sharpness 
    Process sharpness using one of the 11 stages (Figure 2.2.4.2). If the setting is “0 (Default)”, sharpness 
    is not processed. 
  Moving to the minus (-) side blurs the image and moving to the plus (+) side sharpens the image. 
 
Color Adjustment 
    None 
        Synchronized with the ICM Method in the Advanced settings. If this check box is selected, ICM is 
        disabled, the Color adjustment tab is also disabled, and the printer driver does not carry out color 
        adjustment. 
    Handled by Driver 
        If this check box is selected, ICM is disabled, and the 2.2.5 Color Adjustment is enabled. The result 
        is applied to the adjustment values of the following items: Gamma, Brightness, Contrast, and 
        Chroma. 
    ICM 
        Synchronized with the ICM Method of the Advanced settings (ICM Handled by Host System). If this 
        check box is selected, the driver manages colors. 
    ICM & Driver 
        If this check box is selected, ICM (color management) and the 2.2.5 Color Adjustment are enabled. 
 
Language 
    Change the display language for the following items: “Option”, “Color Adjustment”, and “Printer Info”. 
    The selected language is enabled the next time the print settings are displayed. 
 
    [Available languages] 
   ・Japanese 
   ・English (US) 
   ・French (France) 
   ・German (Germany) 
   ・Russian (Russia) 
   ・Spanish (Spain) 
   ・Italian (Italy) 
   ・Korean 
   ・Chinese (People's Republic of China) 
   ・Chinese (Taiwan) 
 
   ・When your operating system environment corresponds with one of the above settings, the default 
     display language is the language of the corresponding country. 

Furthermore, when your operating system environment does not correspond with one of the above 
settings, the default display language is English. 

 
   ・To use a language different from that of your operating system, you must install the following font for 
     the corresponding language. 
 

Language Font 
Japanese Meiryo / Yu Gothic UI <Windows10> 
English (US) Segoe UI 
French (France) Segoe UI 
German (Germany) Segoe UI 
Russian (Russia) Segoe UI 
Spanish (Spain) Segoe UI 
Italian (Italy) Segoe UI 
Korean Malgun Gothic 
Chinese (People's Republic of China) Microsoft YaHei 
Chinese (Taiwan) Microsoft JhengHei 

 
About 

 Show the driver version.  
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2.2.5 Color Adjustment 

 If the Handled by Driver check box is selected in the 2.2.4 Option, the adjustment values of the Color 
Adjustment tab are applied to the image.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 The following section shows the setting ranges on the Color Adjustment tab. 
 

Adjustment item Adjustment value 
Gamma -100 (dark) to 100 (bright) (“0” results in no adjustment, γ2.0 to 0.5) 

Adjust the density of the half-tone section of the image. Increasing the gamma value 
brightens the half-tone section. 
Sync check box 
 ON: Set RGB to same value. 
 OFF: Set RGB to different value. 
 

Brightness -100 (dark) to 100 (bright) (“0” results in no adjustment) 
Adjust the brightness of the image. Increasing the brightness value brightens the entire 
image. 
Sync check box 
 ON: Set RGB to same value. 
 OFF: Set RGB to different value. 
 

Contrast -100 (weak) to 100 (strong) (“0” results in no adjustment) 
Adjust the contrast of the image. Increasing the contrast value increases the difference 
of brightness and darkness. 
Sync check box 
 ON: Set RGB to same value. 
 OFF: Set RGB to different value. 
 

Chroma -100 (weak) to 100 (strong) (“0” results in no adjustment) 
Adjust the chroma of the image. 
 

  
  

Fig 2.2.5  Color Adjustment tab 
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2.2.6 Gray Adjustment 

Gray adjustment is a function to adjust the tone of printouts. 
You can adjust the tone of printouts by specifying any of the 91 (including the default) settings. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Enable gray adjustment function 
Enables or disables the gray adjustment function. (Enabled when the check box is selected.) 

 
Print Test Chart 

Prints a test chart. The print size is fixed to 8 x 5 inches. 
 
Selected gray 

Indicates the gray adjustment value selected with the A1 to K6 buttons. 
 
A1 to K6 gray adjustment selection buttons 

Check the test chart print result and then select the gray adjustment value. 
The selected value is emphasized by light blue. The default value is F6 Std (standard). 

 
<Gray adjustment procedure> 

Step 1. Print a test chart. (The test chart is printed using the default value regardless of the selected gray 
adjustment value.) 

Step 2. Check the print result and click the gray adjustment selection button A1 to K6 with which you wish 
to make the adjustment. 

Step 3. Enable the gray adjustment function. When the check box is selected, the gray adjustment value 
is reflected in the image. 

 
 

 
 
 
 
  

Step 1. Print a test chart. 

Step 2. Select a gray adjustment value. 

Step 3. Enable the gray adjustment function. 
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2.2.7 Printer information 

View the printer information. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The following section shows the information displayed in the Printer Info tab. 
Display item Display details 
Media Info This area shows the type, the size, remaining number of printable sheets for the ribbon media 

and the paper type in the printer. 
* Media information is not displayed when a media type not supported by the printer has been 
loaded. (Figure 2.2.7.2) 

Printer Status Displays the status of the printer using icons and characters. 
 

Display icon 
(Color) 

Display characters Status/Response 

 
(Green) 

Waiting Printing is possible. 

 
(Blue) 

Printing The printer is printing. 

 
(Yellow) 

Door open Front door is open. 
Close the front door. 

 
(Yellow) 

Ribbon end No ribbon remains. 
Load new media. 
(Replace the paper and ribbon as a set.) 

 
(Yellow) 

Paper end No paper remains. 
Load new media. 
(Replace the paper and ribbon as a set.) 

 

  

Fig 2.2.7.1 Printer Information tab Figure 2.2.7.2 Display when incorrect media is loaded 
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Display item Display details 
Printer Status  

 
* A warning message is displayed when a media type not supported by the printer has been 
loaded.(Figure 2.2.7.2) 
 

Display icon 
(Color) 

Display characters Status/Response 

 
(Gray) 

Offline The printer cannot be recognized. 
Connect the printer and computer, and then turn on 
the power. 

 
(Purple) 

Cooling head The head is being cooled. 
Please wait a while. Printing will resume 
automatically. 

 
(Orange) 

Ribbon error The ribbon is not set correctly. 
Reload the ribbon properly. 

 
(Orange) 

Paper size 
setting error 

The printer settings and size of the installed ribbon 
do not match. 
Check the paper size setting and ribbon size. 

 
(Orange) 

Paper jam A paper jam was detected. 
Remove the paper and reload it properly. 

 
(Orange) 

No scrap box The scrap box is being detached. 
Attach the scrap box. 

 
(Red) 

System error System error. 
Restart the printer and computer. If the printer does 
not recover after the restart, contact the service 
center. 

Total Count Total count of printed sheets. 
Firmware Version Version of the control program of the printer. xx.xx indicates the version. 

・CX-02WA xx.xx (For the United States) 

・CX-02W xx.xx  (For other countries) 
Serial No. Serial number of the printer. 
Color Control Data Printer color control data. 

 
 
  



 

29 
CITIZEN SYSTEMS JAPAN CO., LTD. 

 

[CX-02W/CX-02W (A) Printer Driver] User’s Manual (For Windows 7, 8 and 10) 
 

 

2.3 Default values for settings  
 
 The following section shows the default values of the settings (at installation). If the settings have been 
changed, and the printer driver no longer operates normally, return to the default values shown below. 
 
 Note) Depending on the service pack of your operating system or your usage environment, the default 
      values at installation may differ from those in the chart below. 
 
 

Chart 2.3 Default print settings 
Tab Setting Value 

Layout 
Orientation Portrait 
Page Order Front to Back 
Pages Per Sheet 1 

Paper/Quality Color Color 

Option 

Border Disable 
Sharpness 0 (Default) 
Color Adjustment ICM 
Language setting English 

Gray Adjustment Enable gray adjustment function Disable 
Selected gray F6 (standard) 

Color Adjustment 

Gamma 0 
Brightness 0 
Contrast 0 
Chroma 0 

Advanced 
settings 
(In the Layout tab, 
click “Advanced...”) 

Paper/Output 
Paper Size Depends on printer 

media size (*1) 
Copy Count 1 

Graphic 

Print Quality High-speed 
Image 
color 
management 

ICM Method ICM Handled by Host 
System 

ICM Intent Pictures 

Document 
options 

Advanced Printing Features Enabled 
Pages per Sheet Layout Right then Down 

Printer function 

Border Disable 
Overcoat Finish Glossy 
Print Re-try Enable 
High density Disable 

 
*1: For the initial values of paper sizes, see “2.2.2 Advanced options”. 
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2.4 Color management  
 
Use Color management to specify the color profile. The installer associates “SD_CX02W_xxxx.icc” and 
“PP_CX02W_xxxx.icc” by default. 
 
This printer driver automatically changes the color profile for the media that is loaded in the printer. 
 
To use an ICC profile other than the default profile, overwrite the ICC profile that has been registered as the 
default. 
 
For the ICC profile to overwrite, prefix “SD_” to the profile name for Digital media and prefix “PP_” to the 
profile name for Pure Premium media and Luxury media. 
 

Example: Overwritten profile name 
・ For Digital :  SD_xxxxxxxx.icc 

・ For Pure Premium, Luxury :  PP_xxxxxxxx.icc 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

Step 1.  From the Printer Properties, select the 
Color Management tab, and then click “Color 
Management...”. 

Step 2.  From Device, select “CITIZEN CX-02W”. 

The installer associated this file 

Fig 2.4.1  Color Management Tab 

Fig 2.4.2  Color Management Window 
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2.5 Print Area  
 
The following section shows the image sizes and numbers of dots generated by the paper size setting of the 
driver. 
 

Paper size 

Image size 
(width x height) 

Number of image dots 
(width x height) 

(inch) (mm) 
High-speed 

(300x300dpi) 
High-quality 

(600x600dpi)*1 
(8x4) 8”x 4” 207.3 x 104.6 2448 x 1236 4896 x 2472 

(8x5) 8”x 5” 207.3 x 130.0 2448 x 1536 4896 x 3072 

(8x6) 8”x 6” 207.3 x 155.4 2448 x 1836 4896 x 3672 

(8x8) 8”x 8” 207.3 x 206.0 2448 x 2436 4896 x 4872 

(8x10) 8”x 10” 207.3 x 257.0 2448 x 3036 4896 x 6072 

(8x12) 8”x 12” 207.3 x 307.8 2448 x 3636 4896 x 7272 

A5 Format 8.3” x 5.8” 214.0 x 151.5 2528 x 1790 5056 x 3580 

A4 Format 8.3” x 11.7” 214.0 x 300.0 2528 x 3544 5056 x 7088 
 

*1: Convert to 300 x 600 dpi size within the driver, and then send to the printer. 
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2.6 Orientation  
 
The following chart shows the relationship of images generated by an application and printed items (output 
direction) according to the orientation setting. Generated images are not the original image rotated by the 
application but are zoomed to fit within the sizes is shown in “2.5 Print Area”. 
 

 
 

  

Original 
image 

Driver setting 
Orientation Paper setting 

(8x4) 
(8x5) 
(8x6) 
(8x8) 
A5 Format 

(8x10) 
(8x12) 
A4 Format 

Generated image Printed item 
(Output orientation ↓) Generated image Printed item 

(Output orientation ↓) 

 

 
 
 
 
Portrait  
 
 
 

 
 
 
 

 
 
 

 
 
 
 
   

 
 
 
Landscape 
 
 
 

 
 

 
 
 
 
 
 

 
 
 
 
 
 

 

 
 
 
 
Portrait  
 
 
 

  

 
 
 
 
 

 
 

 
 
 
 
 
 

 
 
 
 
Landscape 
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Chapter 3 Update the driver 
 
As when performing the installation, log in as an administrator before carrying out this operation. 
 
1. Check the job 

1) Before updating the printer driver, close all applications. Furthermore, click on the icon of the printer to be 
updated in the Devices and Printers screen. At the bottom area of the screen, confirm that there are no 
documents in the queue, and then start update of the driver. 

 
Note: In Windows 8 and 10, when the printer is offline (the printer is not on and connected), the “CITIZEN 

CX-02W” icon is not displayed. Always connect the printer with the power turned on and check that 
there are no documents in the queue. 

 

 
Figure 3.1 Clicking the “CITIZEN CX-02W” icon at the Devices and Printers screen 
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2. Uninstall the driver package 

1) Click “Start”, and then click “Windows System” -> “Control Panel”.  In the Control Panel, click “Uninstall a 
program”. 
In Windows 7, click “Start”, and then click “Control Panel”.  In the Control Panel, click “Uninstall a 
program”. 
In Windows 8, right click the “Start” screen.  In the bottom right area, select “All Apps”, and then select 
“Control Panel”.  In the Control Panel, click “Uninstall a program”. 

 

 
Figure 3.2 Control Panel 

 
 

2) The Uninstall or change a program screen appears. In the list, double click “CITIZEN CX-02W”. 
 

 
Figure 3.3 Uninstall a program 
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3) Click “Yes” when the CITIZEN CX-02W uninstall confirmation windows appears. 
  Uninstalling the driver is complete. After uninstalling the printer package, restart the computer. 

 

 
Figure 3.4 Uninstallation confirmation 

 
 
    When a User Account Control dialog box appears, click “Yes”. 
 

 
Figure 3.5 User Account Control 

 
 
3. Install an upgrade for the printer driver 

After deleting the printer and the printer driver, install the new printer driver. For the installation procedure, 
see “Chapter 1 Installation”. 

 
 
4. Restart the computer 

After the installation of the printer driver is complete, always restart the computer. 
(Do not print just after installation. Always restart the computer once.) 
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Chapter 4 Delete the driver 
4.1 Automatic deletion of printer drivers 
 
The printer driver is automatically deleted when uninstalling the driver package. 
For the steps to uninstall the driver package, see “2. Uninstall the driver package” in Chapter 3. 
 
Note that uninstalling the driver package when the printer driver is in use will display the following message, 
and the printer driver will not be deleted. 
 

 
Figure 4.1 Message displayed when the driver is in use 

 
When the above message is displayed, restart the computer and then delete the printer driver using the 
procedure described in “4.2 Manual deletion of printer drivers”. 
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4.2 Manual deletion of printer drivers 
 
1) Click “Start”, and then click “Windows System” -> “Control Panel”.  In the Control Panel, click “View 

devices and printers”. 
In Windows 7, Click “Start”, and then click “Control Panel”.  In the Control Panel, click “View devices and 
printers”. 
In Windows 8, right click the “Start” screen.  In the bottom right area, select “All Apps”, and then select 
“Control Panel”.  In the Control Panel, click “Devices and Printers”. 

 
From the Devices and Printers screen, right click “CITIZEN CX-02W”.  From the menu, click “Remove 
device”. 

 

 
Figure 4.2.1 Right clicking “CITIZEN CX-02W” in the Devices and Printers screen 
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In Windows 8 and 10, when the printer is offline (the printer is not on and connected), the “CITIZEN 
CX-02W” icon is not displayed. In such cases, use the following procedure to delete the device. 
 

(i) On an empty area in the Devices and Printers screen, right click, and then select “Device Manager”. 
 

 
Figure 4.2.2.i Right clicking on an empty area in the Devices and Printers screen 

 
(ii) Click “View”, and then select “Show hidden devices”. 
 

 
Figure 4.2.2.ii Displaying the View menu for hidden devices 

 
 
(iii) Under “Printers”, right click “CITIZEN CX-02W”, and then select “Uninstall device”. 
 

 
Figure 4.2.2.iii Displaying the menu to delete CITIZEN CX-02W 

 
(iv) At the Uninstall Device screen, click “Uninstall”. 
 

 
Figure 4.2.2.iv Uninstall Device screen 
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2) The printer deletion confirmation dialog box appears. Click “Yes”. 

 

 
Figure 4.2.3 Printer deletion confirmation dialog box 

 
 

3) After deleting the “CITIZEN CX-02W” printer, select another printer (for example, Fax), and then click 
“Print server properties” in the menu bar. 

 

 
Figure 4.2.4 Displaying the Print server properties menu in the Devices and Printers screen 
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4) The Print Server Properties dialog box appears. Click the “Drivers” tab. From the installed printer driver 

list, select “CITIZEN CX-02W”, and then click “Remove...”. 
 

 
Figure 4.2.5 Printer Server Properties dialog box 

 
 

5) The Remove Driver And Package dialog box appears. Select “Remove driver only”, and then click “OK”. 
 

 
Figure 4.2.6 Remove Driver And Package dialog box 
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6) The Print Server Properties confirmation dialog box appears. Click “Yes”. 

 

 
Figure 4.2.7 Driver deletion confirmation dialog box 

 
 

If the following message appears, the operating system may be using the driver (Print Spooler service) in 
the background.  
Disconnect the USB cable and then restart your computer and try deleting the printer driver again. 

 

 
Fig 4.2.7.i  Driver in use 

 
 
 

7) In the Print Server Properties dialog box, confirm that “CITIZEN CX-02W” was deleted, and then click 
“Close”. 

 

 
Figure 4.2.8 Print Server Properties 
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